
Many contractors who use spreadsheets are
doing more work than they have to simply
because they don’t understand how to
make the spreadsheet do the work for

them. In this article, I’ll show
you a handful of simple tech-
niques that will take the mys-

tery out of using multiple worksheets and building for-
mulas. You can skip over anything that seems too basic,
but I’m betting that even experienced users will discover
something new.

The sample spreadsheet used here is designed to help
you plan tool and equipment purchases, and to compare
actual expenses to budgeted costs. But the setup proce-
dures and formulas will work in spreadsheets that per-
form basic accounting, estimating, job costing, and
many other common paperwork chores in a small con-
struction company.

I use Microsoft Excel 97, but Lotus 1-2-3 or any other
professional spreadsheet will work equally well, so long as
it can provide multiple worksheets in the same file. A tem-
plate is also available for download from jlcnet.com/
downloads, and should be compatible with most popular
spreadsheet programs.

If you’ve never used a spreadsheet, you can find more
information in either Excel 97: Fast & Easy (Visual
Learning Guides) by Nancy Stevenson, or The Essential
Excel 2000 Book by Faithe Wempen and Donna Payne.
You can also arrange to have free daily tips on Excel (and
dozens of other programs) delivered via e-mail by sign-
ing up at www.tipworld.com.

Create the Workbook
From the File menu, select New to create a blank work-

book, which automatically opens with three blank,
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tabbed worksheets. Rename the three blank sheets
Summary, Budget, and Expenses (see Figure 1). The
Budget sheet is where you will plan how much to spend
for the year on new tools and equipment, and on
maintenance of existing inventory. Throughout the
year, you will record actual expenditures on the
Expenses sheet. The Summary sheet will display subto-
tals from the other two sheets and compare budgeted
costs with actual expenses.

List Main Categories 
The next step is to set up the categories you want to

track. These will vary depending on how you run your
business, but let’s start with three types of purchases:
general tools for daily use on site; equipment, such as
generators and ladders, that will move from job to job;
and tools and equipment for the company shop. You
may also want to set up a fourth category to track main-
tenance costs for tools and equipment you already own.

Click on the Summary tab and type the list of cate-
gories into Column B as shown in Figure 2. The blank
rows at the top of the sheet will be used for the title
block, and the blank row between each category will
make the worksheet easier to read. 

Next, click on the Budget tab and enter your cate-
gories again, but this time leave plenty of blank rows
between them, as shown in Figure 3. The blank rows
make room for you to record individual tool or equip-
ment purchases planned for the coming year. Formulas
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Figure 1. To rename a worksheet, right-
click on the tab, select Rename from the
menu (top), and type the new name
(above). Alternatively, double-click on the
tab and type the new name.

Figure 2. Type the list of categories
into Column B, leaving a blank
row between each one to make
the list easier to read. Also leave
blank rows at the top of the sheet
to make room for a title block.

Figure 3. With the category headings entered in every
tenth row (B5, B15, B25, and B35), there’s plenty of
room for itemized lists of planned purchases. Color is
optional and can be added later, but it makes the work-
sheet easier to read.

Renaming Worksheets

Planning for Data



in selected cells on this sheet will feed data entered here
to the subtotals in the Summary sheet.

Add Navigation
All those extra blank rows push most of the spread-

sheet off the bottom of the screen, making it cumber-
some to move back and forth between categories. One
solution is to create a navigation block at the top of the
sheet using “hyperlinks” for each category, as shown in
Figure 4. When you click on the hyperlink, you jump
immediately to the corresponding category.

Freeze panes. Hyperlinks make it easy to jump to cat-
egories, such as Maintenance, that have scrolled off the
bottom of the screen. But making the jump creates the
opposite problem: When you arrive at the Maintenance
category, all of the categories above it have now scrolled
off the top of the screen.

One solution is to add hyperlinks at each category
heading that will send you back to the top of the list. An
easier solution, however, is to freeze the top four rows,
as shown in Figure 5. Now when you jump to the bot-
tom of the list, the navigation block — as well as the col-
umn headings — are always in plain view. 

Add Data
It’s easier to troubleshoot formulas if you have some

data to work with, so the next step is to fill in some of
the blanks on the Budget sheet. Begin by listing any tools
and equipment you plan to purchase in the coming year,
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Figure 4. To create a hyperlink:
1. Highlight the cell you want to link. 
2. From the menu, choose Insert, then Hyperlink (or press

CTRL K on the keyboard) to open the hyperlink dialog.
3. Click the upper Browse button to find the worksheet

you’d like the link to point to. 
4. Click the lower Browse button and select the cell the

link will jump to.
5. Click OK.

Figure 5. When you select Freeze Panes from the Window
menu, all rows above the highlighted cell are fixed in place
and will not scroll with the rest of the sheet. 

Making Hyperlinks

Freezing Rows



one item per row. Add the estimated purchase
price in the Amount column. If you’re unsure
of the price, take a guess — one of the advan-
tages of planning on a spreadsheet is that you
can easily make changes later.

Do the same for each of the other cate-
gories. Filling in the Maintenance items will
probably take the most time, since it requires
inspecting the tools and equipment you
already own, and estimating the cost to repair
or maintain them in the coming year. You
don’t have to complete this inventory before
you continue building the spreadsheet, but it
will help to have some numbers in the
Amount column to make sure the formulas
are working correctly. The spreadsheet won’t
be useful, of course, till all of the information
it holds is up-to-date.

Add Formulas
Although the spreadsheet seems compli-

cated, there are only a few formulas tying it
all together. Here’s a step-by-step description
of how to build the formulas needed on
each sheet.

Simple arithmetic. In Excel, most formu-
las begin with an equals sign (=), and the
simplest formulas use arithmetic “operators”
(+,-,*, /) to add, subtract, multiply, or divide
the contents of two or more cells.

On the Budget sheet, for example, we need
a formula in every cell of the Total column
that multiplies the quantity by the dollar
amount for each line item. The easiest way to
do this is to create the formula in the topmost
cell, then copy it into all of the other cells
(Figure 6). 

Autosum. Another simple formula used
over and over on the spreadsheet is one that
adds a row or column of numbers and dis-
plays the total. On the Budget sheet, for
example, the formula appears in the cell
immediately below each category heading,
and displays the total budget amount for
each category.

The easiest way to enter the formula is to
use the Autosum feature (Figure 7). After
building the formula in cell B6 for the Tools
category, you could use Autosum again in cell
B16 for Equipment, but again it’s easier to
copy it instead. Once again, the spreadsheet
automatically adjusts the formula range from
cells F5:F14 to F15: F24.
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Figure 7. To display the sum of the Amount column for the category A. Tools:
1. Click on the cell where you want the sum to display (B6).
2. On the toolbar, click the Autosum icon , which inserts the first

part of the formula — =SUM() — into the cell, and changes the
mouse cursor from an arrow to a plus sign.

3. Click and drag the cursor between the first and last cells you want
to add, then hit ENTER.

The final formula is =SUM(F6:F15), which displays the sum of all cells
between F6 and F15. (To use Autosum for cells that are not aligned in a
row or column, hold down the CTRL key while clicking on the cells or
groups of cells you want to include.)

Figure 6. To copy a formula into a block of cells:
1. Highlight the cell holding the formula you want to copy (in

this case, F6).
2. Press CTRL C to create a copy of the cell (or choose Copy

from the Edit menu).
3. Click and drag to highlight the destination cells (F7 to F10),

then press ENTER

Copying a Formula

Using Autosum



Worksheet to worksheet. In several places
in the spreadsheet, a cell in one worksheet dis-
plays a value from another worksheet. On the
Summary worksheet, for example, values for
the Budget Amount column are supplied by
formulas linked to the Budget worksheet
(Figure 8).

Copy Between Worksheets
Likewise, the values in the Actual column

come from formulas on the Expenses work-
sheet, which we’ve left blank till now. We
could manually type the categories into this
sheet, but it’s easier to copy them from the
Budget sheet, formulas and all, because that
worksheet is already set up to handle itemized
lists of tools and equipment.

All we really want to copy are the first two
columns (Figure 9). To complete the sheet, 
add the labels Amount, Vendor, Invoice,
Description, Manufacturer, and Model to
columns C through H.

Edit Hyperlinks and Formulas
If you now click on one of the hyperlinks on

the Expenses sheet, you’ll jump immediately
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Figure 8. To link values from the Budget sheet to the Summary sheet:
1. Type an equal sign (=) in cell C8 of the Summary sheet to start
the formula (left).
2. Click the tab for the Budget worksheet.
3. Click on cell B6, the cell that holds the budget total for the
Tools category (right), and press ENTER.

Figure 9.
To copy entire columns, including
formulas, from the Budget to the
Expenses worksheet:

1. Click and drag across the let-
ters A and B at the top of the
Budget work area — this will
highlight every cell in both
columns.

2. Press CTRL C (or select Edit,
then Copy from the menu bar).

3. Click on the Expenses work-
sheet tab to switch to that
sheet.

4. Place the cursor in cell A1 and
hit ENTER.

Linking Worksheets

Copying Columns



back to the Budget sheet. That’s because the copied
hyperlinks still refer to cells on the sheet where they
were first created. 

To fix the hyperlinks, you need to change the sheet
name they refer to (Figure 10). Do this four times on
the Expenses sheet, once for each of the four category
hyperlinks.

There’s also a small problem with the formulas we
copied into Column B. These formulas, you’ll
remember, display the value in the Total column,
which on the Budget sheet is in column F. The
Expenses sheet has different column headings, how-
ever, and the value we want to display is the total of
Column C (Amount).
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Figure 11. You can change the Autosum formula
by typing directly into the cell that holds it.
First, double-click the cell, which displays a
blue outline around the reference cells (above).
Replace the incorrect column reference (F) with
the correct one (C), and hit ENTER. To check the
results, double-click the cell again — this time
the blue outline surrounds the correct group of
cells (right). Hit ESC to cancel the edit.

Figure 10. To change a hyperlink, right click on the cell
containing the hyperlink formula, and select Edit
Hyperlink from the menu (left). Click on the lower browse
button, select a new “Sheet name” from the list, and type
in the new cell “Reference” (right).

Editing Hyperlinks

Editing a Formula



Fortunately, it’s easy to correct the formulas. You
can either create a whole new formula using
Autosum, or simply edit the existing formula
(Figure 11). 

These four cells on the Expenses sheet (in our exam-
ple cells B6, B16, B26, and B36) are the cells you will
link to fill in the values on the Summary sheet. To
make these links, follow the process outlined earlier
in Figure 8, but make sure you don’t get the work-
sheets mixed up.

Final Formulas
All that’s left is to complete the formulas on the

Summary sheet. First, at the bottom of the Budget
Amount column, use Autosum to total cells C7 to C14.
Then copy the formula to the bottom of the Actual
Amount and Variance columns (E15 and G15).

Variance column. Finally, build a formula in the
Variance Amount column that subtracts the Actual
Amount from the Budget Amount (Figure 12). Then
copy the formula into cells G10, G12, and G14.

Add Color and Formatting
With all of the formulas and hyperlinks in place,

the spreadsheet is essentially complete. But adding
color and changing the formatting of certain cells will
make the worksheets easier to read and understand.

First, add three colors to the Summary worksheet to
distinguish the Budget, Actual, and Variance columns
from each other (Figure 13).

Next, to make it easier to tell the difference
between the Budget and Expenses worksheets, color
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Figure 12. To build a formula that calculates the difference
between values in the Budget and Actual columns:

1. Click on cell G8 in the Variance column and type an
equals sign (=) to start the formula.

2. Click on C8 in the Budget column.
3. Type a minus sign (-).
4. Click on E6 in the Actual column, and press ENTER.

Figure 13. To change the background color, first
highlight the cells you want to color, then click the
color icon on the menu bar. (Alternatively, open
the Format menu and click on Cells, then select the
Patterns tab). When you click on the color you
want from the drop-down color chart, the high-
lighted cells fill with that color. To remove color,
select “no color” from the color chart. 

Adding Color

Building a Variance Formula



one blue and the other green. To make the category
subtotals stand out, use a slightly darker shade of
the same color.

Merge cells. To display the worksheet titles in a
larger size, first merge the group of cells that will hold
the title, then change the point size of the type
(Figure 14).

Protect formulas. The Summary worksheet never
needs input from the keyboard, because it uses for-
mulas to copy values from other worksheets. To pre-
vent anyone from accidentally overwriting these
formulas, you can lock or “protect” the entire work-
sheet (Figure 15). You can do the same to the other
two worksheets, but you’ll have to “unprotect”
them whenever you need to add or change the con-
tents of a cell.

Joe Stoddard is technology editor at the Journal of
Light Construction.
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Figure 15. To prevent someone from accidentally overwrit-
ing important formulas, you can lock an entire worksheet.
From the Tools menu click Protection, then select Protect
Sheet. (If the sheet is already protected, the command
changes to Unprotect Sheet, and clicking it will unlock
the sheet.)

Figure 14. You can merge several cells to create a single
wider or taller cell. Highlight the cells you want to com-
bine, then click Format on the menu bar. Choose Cells
from the dropdown menu, then click the Merge Cells box
on the Alignment tab (left). Now you can increase the point
size of the text so the title fills the larger box (right).

Locking Cells

Merging Cells


